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Manufacturer’s responsibility

The manufacturer, installer, or importer will be responsible for the safety, reliability, and performance
of the equipment only if:

+ Installation, modifications, adjustments, changes, or repairs are performed by suitably qualified
service personnel.

+ The electrical installation of the site in which the equipment is used is according to an applicable
safety standard (UL, CSA, or IEC/CDE).

* The equipment is used according to the instructions provided in the operation manuals.
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External software licenses

(Topic number: 7696)

Information about third-party software licenses and copyrights can be found in External
software licenses (refer to page 53).

Giving feedback on the documentation

(Topic number: 122201)

Thank you for taking the time to provide feedback. Your comments will be forwarded to the group
responsible for this product’s documentation.

To give feedback on the documentation

1. In an email subject line or body, list which product, version, and publication you are
commenting on.

For example, “IMPAX 6.4 SU01 Client Knowledge Base: Extended*. (You can find this
information in the footer of the publications.)

2. Describe the incorrect, unclear, or insufficient information. Or, if you found any sections
especially helpful, let us know.

3. Provide topic titles and topic numbers where applicable.
Including your personal contact details is optional.

4. Send the email to doc feedback@agfa.com.

Sorry, we cannot respond directly to every submission and we cannot accept requests for changes
in the product; instead, contact your product sales representative or the product’s technical support
channel.
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Getting started

Understanding IMPAX, Curator, the CD Export server, and the hardware and software components
required for Curator and the CD Export server helps ensure a successful installation.

Prerequisite knowledge: IMPAX installations

(Topic number: 7633)

The installation procedures require that you have general knowledge of computer hardware and
software concepts and proficiency in operating and troubleshooting computer software.

What is IMPAX?

(Topic number: 6910)

IMPAX is an image archiving and communications system that eliminates the need for film because
it receives, distributes, archives, and displays images. IMPAX automates the flow of information to

integrate the Radiology department with the rest of the hospital. IMPAX can also integrate remote
locations such as clinics or home offices to the system for offsite viewing of images.

Additional IMPAX documentation

(Topic number: 6911)

This guide is intended for service and administrative personnel who are installing or upgrading,
configuring, and maintaining the Server components of the IMPAX 6.5.1 system.
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For information about using the IMPAX software once it is installed, refer to the IMPAX 6.5.1 Server
Knowledge Base, IMPAX 6.5.1 Application Server Knowledge Base,and IMPAX 6.5.1 Client Knowledge
Base: Extended. These Knowledge Bases are installed on the Application Server. Refer to “Installing

the IMPAX documentation” (topic number 15523) in the IMPAX 6.5.1 Application Server Installation,
Upgrade, and Configuration Guide.

Opening the IMPAX 6.5.1 Server Knowledge Base

(Topic number: 58560)

Follow this procedure to open the IMPAX 6.5.1 Server Knowledge Base.

To open the IMPAX 6.5.1 Server Knowledge Base
1. Ensure that the IMPAX documentation has been installed.

2. Launch the IMPAX Administration Tools and log in. Select Help > Help URL. On the IMPAX
Documentation page, click the IMPAX Server Knowledge Base link.

or

From a browser on a connected computer, navigate to
https://app_server_name/impax/documents/server/default.htm

Opening the IMPAX 6.5.1 Application Server Knowledge Base

(Topic number: 58563)

Follow this procedure to open the IMPAX 6.5.1 Application Server Knowledge Base.

To open the IMPAX 6.5.1 Application Server Knowledge Base
1. Ensure that the IMPAX documentation has been installed.

2. On the Application Server, double-click the AGFA IMPAX Knowledge Base desktop shortcut.
Select the IMPAX Application Server Knowledge Base link.

or

From a browser on a connected computer, navigate to
https://app_server_name/impax/documents/appserver/default.htm

Opening the IMPAX 6.5.1 Client Knowledge Base: Extended

(Topic number: 58566)
Follow this procedure to open the IMPAX 6.5.1 Client Knowledge Base: Extended.

To open the IMPAX 6.5.1 Client Knowledge Base: Extended
1. Ensure that the IMPAX documentation has been installed.

2. Launch the IMPAX Client application and log in.
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3. Press F1.

What is Curator?

(Topic number: 7018)

The Curator process is responsible for compressing incoming images into the Mitra Wavelet format
and storing them in the web cache. These studies can be accessed by remote Clients over the World
Wide Web or by local display Clients. Wavelet images provide the advantage of partial file transfer,
meaning that IMPAX can display a low-resolution view of these images very quickly and can
automatically update the display with higher resolution views as they cross the network, until the
required resolution of image has been retrieved.

Multiple instances of Curator can be supported. If more than one Curator is installed, the first
Curator instance that is started is considered the master Curator. The master Curator owns the web
cache and is responsible for servicing requests from the IMPAX Application Server and from IMPAX
Clients. The Autopilot running on the master Curator is responsible for the web cache. Each additional
Curator checks for PREPARE jobs in the queue associated with the master Curator and writes to
the web cache owned by the master Curator.

Understanding how Curator manages web images

(Topic number: 7021)

When accessing IMPAX over the Internet, connection speeds are typically much slower than within
the hospital network. To minimize the effect on users, Curator processes images in the image cache,
creates Mitra wavelet compressed images Mitra wavelet compressed images (lossless, by default),
and stores the wavelet images in the web cache. Wavelet images provide the advantage of partial file
transfer, meaning that IMPAX can display a low-resolution view of these images very quickly and
can automatically update the display with higher resolution views as they cross the network, until
the required resolution of image has been retrieved. The wavelet images can be accessed by both
local and remote Clients.

The role of the master Curator
(Topic number: 7025)

To distribute the compression work, multiple Curators can run concurrently in IMPAX, contending
for PREPARE jobs and storing curated images to the shared web cache or caches. The first Curator
started is considered the master Curator, and any additional Curators are considered secondary or
slave Curators.

When the master Curator is started, it creates a Curator job queue and starts managing the web
cache. The master Curator and secondary Curators check for PREPARE jobs in the Curator job
queue, process the images into Mitra wavelet format, and store the images in the web cache. Although
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the Curator job queue and the web cache are owned by the master Curator, PREPARE jobs are
associated with the Curator process that accepts the job.

The DICOM Storage Cache Server (using SPFTP) and DICOM Authenticated Storage Cache Server
(using ASPFTP) provide images to the IMPAX Application Server and IMPAX Clients (respectively)
and are installed with Curator. Because the master Curator owns the web cache, only it is responsible
for servicing requests for wavelet images. The secondary Curator processes only curate images and
store them to the web cache. Both master and slave Curators can read and write to the web cache,
but to configure the distribution of wavelet images so that all Curators can service requests for
images, a load balancer is required.

% Note:

All Curator processes must have unauthenticated access to the shared web cache. If Curator
and Network Gateway components are installed together, all caches (image and web) must
be shared.

Autopilot is installed with all Curators, but only the Autopilot running on the master Curator is
responsible for managing the web cache. If the master Curator fails or is unavailable for an extended
period of time, a secondary Curator can be configured to take the role of the master Curator, taking
ownership of the web cache and the Curator job queue.

Overview of Curator processes
(Topic number: 7034)

The following diagram illustrates the general flow of images between the image cache and web cache:

2 Curator queue

\A Curator

==

1

4
— Image cache e == —_— Web cache

1. As studies arrive from the SCP or are retrieved from the archive, each study object is stored in
the image cache and a STUDY_ARRIVED notification is created.

2. Task Scheduler receives the notification, creates a PREPARE job for the study, and places the
job in the Curator job queue.

3. The next Curator to check the Curator job queue takes ownership of the PREPARE job and
reads the study objects from the image cache.

4. Curator compresses the appropriate objects using the Mitra wavelet format and stores them
in the web cache.

For each object in the study, Curator considers the following:

+ If the object is already in the web cache, it is not processed again.
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« If Mitra wavelet compression is required, the object is processed, compressed, and stored
to the web cache. Curator generates a new DICOM header for each image.

« If Mitra wavelet compression is not required, the object is copied to the web cache. This
prevents image access privilege problems and reduces partial study problems arising from
studies being spread across multiple AE_REFs.

5. After the study is processed, Curator sends an MVF notification and, if configured, an EPR
notification to indicate that new wavelet images are available.

How does Curator process images?
(Topic number: 7057)

The following changes are made to images processed by Curator:

« PALETTE data is converted to RGB without loss of data. Photometric interpretation is also
changed to RGB.

* YBR_PARTIAL data is converted to YBR_FULL without loss of data.
* Any embedded overlays are burned into bit 11, with some loss of data.

+ A slope/intercept is applied to pixel data to reduce the effective bits_stored to 12 bits, with
some loss of data. Special logic is applied to CT images to preserve the Hounsfield Units.

+ If the pixel data is not equivalent to the original, it is marked as lossy compressed. The Derivation
description in the DICOM header file details the changes applied to the pixel data.

What is the CD Export server?

(Topic number: 7016)

The CD Export server processes burn jobs created by the IMPAX Client and prepares the zip files
containing the data for the burn job.

Understanding how the CD Export server works with the IMPAX
Client

(Topic number: 7020)

The AS300 MVFcdexport package installs the software required for the CD Export server. The CD
Export server processes local burn jobs created by the IMPAX Client and prepares the zip files
containing the data for the burn job.
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Application Server

IMPAX Client
CD Export server

Interactions with the IMPAX Client and Application Server

1.

A burn request is created by the IMPAX Client, indicating the information to be included in
the burn job.

. The Application Server creates the burn job and notifies the CD Export server.

. The CD Export server creates the zip file containing:

+ The DICOM files (images and dicomdir)
* An Access database with information about the DICOM objects in the volume
* The clinical report files created by the Application Server

The zip file is transferred to the Application Server, which then passes the file to the IMPAX
Client to perform the burn job.

After the CD has been burned, the IMPAX Client creates a cleanup job to delete the zip files,
images, and reports used for the burn job from the CD Export server cache.

Order of cluster installations

(Topic number: 7763)

The IMPAX cluster has many components and each depends on other components in the cluster.
To correctly install and configure components in the cluster, follow this order of installation:

1.

Install the Database Server, Archive Server, and Network Gateway.

Install the core Server components and create the portable password file required to install
other IMPAX components. Do not configure the AS300 Server components at this time; the
Application Server must be installed before these Server components can be configured. Refer
to the guide appropriate to your configuration.

Required guide: One of IMPAX 6.5.1 AS3000 Installation and Configuration Guide or IMPAX
6.5.1 AS300 Installation and Configuration Guide

Install the Application Server.
Install the Business Application services and IMPAX documentation on the Application Server.

Required guide: IMPAX 6.5.1 Application Server Installation, Upgrade, and Configuration Guide
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3. Begin configuration of the Application Server.

Create and import an SSL certificate, configure ADAM (Windows Server 2003) or AD LDS
(Windows Server 2008), compress web services, set connections to the image and audit servers,
and set logging levels.

Required guide: IMPAX 6.5.1 Application Server Installation, Upgrade, and Configuration Guide

4. Ifyouhaveinstalled a Windows-based Database Server, Archive Server, or Network Gateway,
configure these components.

Configure database backups, image and web caches, and archives (if necessary). In clusters
that include only Solaris-based systems, these configuration steps are done automatically during
the installation.

Required guide: IMPAX 6.5.1 AS300 Installation and Configuration Guide
5. Install and configure Curator and the CD Export server.

If the site requires compressed web images, install and configure one or more Curator systems
and set up the web cache. If you are installing multiple Curators, install and start the master
Curator first, then install and start the slave Curators.

If you will be using the CD Export feature in the IMPAX Client, install the CD Export server.
Required guide: IMPAX 6.5.1 Curator and CD Export Server Installation Guide
6. Complete the configuration of the Application Server.
Complete the optional Application Server configuration tasks that are applicable to the site.
Required guide: IMPAX 6.5.1 Application Server Installation, Upgrade, and Configuration Guide
7. Install and configure Clients.
Install and configure the IMPAX Client, the PACS system used to access images.
Required guide: IMPAX 6.5.1 Client Installation, Upgrade, and Configuration Guide
If installing a standalone station (single-host AS300 with Application Server and Client), refer to the
IMPAX 6.5.1 Standalone Installation and Configuration Guide.

If installing a single-server (single-host AS300 with Connectivity Manager and Application Server),
consult Installing an IMPAX AS300 single-server in the IMPAX 6.5.1 AS300 Installation and
Configuration Guide.

All documentation is available on the IMPAX Documentation DVD.

Order of Curator installations

(Topic number: 7036)

Three possible scenarios exist for working with Curator. For small AS300 sites, you may want to
install and configure Curator on the single-host Database Server or on the Archive Server or Network
Gateway. For medium-sized sites, we recommend installing Curator on its own machine, separate
from the other server components. And for larger sites, we recommend installing two or more
Curators on separate machines, working in a master-slave configuration.
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If you are installing multiple Curators, the general installation order is as follows:
1. Install the master Curator and restart the system.

The Curator job queue is created in the IMPAX database and is associated with the master
Curator.

2. Set up the web cache for the master Curator.
3. If required, configure the default Curator settings in the database.
4. Install and start any secondary or slave Curator systems.

No additional configuration is required for secondary Curators. Only one Curator job queue
exists, and it is owned by the master Curator. The secondary Curators check this queue and
write to the web cache as required.

Although multiple Curators may be installed, each Curator places web representations of
objects into the same web cache. The web cache is owned by the master Curator and managed
by the Autopilot running on the master Curator.

Curator hardware and software requirements

(Topic number: 6714)

We recommend the following hardware and software for a dedicated Curator and CD Export server.

IMPAX Server: External software requirements
(Topic number: 6695)

The following software is required for most IMPAX AS300 servers. Unless otherwise indicated, Agfa
does not provide the software as part of the IMPAX AS300 Server installation package.

Component Requirements

Operating system For upgrades:

Windows Server 2003 R2 SP2, Standard or Enterprise Editions, 32-bit
or 64-bit (only a dedicated Database Server can be run on Windows
64-bit)

or
For new installs:

Windows Server 2008 SP2, Standard or Enterprise Editions, 32-bit or
64-bit (only a dedicated Database Server can be run on Windows 64-bit)

Database software One of the following:

+ Oracle 10g 32-bit Server and Client (provided on Oracle for
Windows 32-bit DVD)

or
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Component Requirements

+ Oracle 10g 64-bit Server (provided on Oracle for Windows 64-bit
DVD)

or

+ Microsoft SQL Server 2005, Standard or Enterprise Edition, with
Service Pack 3 (upgrades only) or Microsoft SQL Server 2008, with
Service Pack 1 (upgrades only)

Browser Internet Explorer 8.0
Java
Documentation Latest version of Adobe® Reader®

Remote access (optional) Symantec pcAnywhere version 12.5

Antivirus McAfee Antivirus 4.5 or higher

IMPAX Server: Hardware requirements
(Topic number: 6690)

The following hardware configuration is recommended for IMPAX AS300 servers (including
single-server configurations).

Component Requirements

Example systems  Preferred:
HP ML370, DL380 (may be deployed with VMware ESX 3.5)
Supported:
Dell 1900, 2900, 2950, 6900*, 6950*
Stratus® ftServer® 4300, 4410, or 5700 (dual CPU)

Hard drive Minimum three drives
Minimum drive size 40 GB
Minimum drive size 73 GB

NAS/SAN connections also supported

RAM 4 GB minimum
Number of CPUs  Two or four* CPUs, 2 GHz minimum each
RAID Embedded RAID (for onboard storage)
Tape backup DAT 72 tape drive, if required for database backup
Video Integrated video
Curator and CD Export Server Installation Guide—IMPAX 6.5.1 15
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Component Requirements

DVD Yes

Network interfaces 100/1000 Mbps
Modem N/A

Power supplies Redundant (additional)
Peripherals Mouse and keyboard

* The use of four-CPU socket servers for IMPAX is supported but not recommended.

** Stratus Servers are no longer supported for new installs.

IMPAX AS300 installation programs

(Topic number: 7684)

IMPAX 6.5.1 AS300 includes four installation programs—two for 32-bit Windows, and two for
64-bit Windows.

Program Purpose

setup.bat (Oracle for 32-bit Install the appropriate version of Oracle Server or Client for

Windows DVD) 32-bit versions of Windows

setup.bat (Oracle for 64-bit Install the appropriate version of Oracle Server for 64-bit

Windows DVD) versions of Windows. Not supported for standalone
configurations.

as300-installer.exe (IMPAX AS300 « Install or upgrade an AS300 Database Server on a 32-bit

installation DVD) version of Windows, under Oracle or SQL Server

+ Install or upgrade an AS300 single-host server (including
standalone and single-server configurations)

+ Install or upgrade an AS300 Network Gateway, Archive
Server, or Curator

as300-installer-x64.exe (IMPAX Install or upgrade an AS300 Database Server on a 64-bit
AS300 installation DVD) version of Windows under Oracle

% Note:

SQL Server 2008 is not distributed with IMPAX but is available from the Agfa Parts Center.
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Installing hardware
and software

Other hardware and software components required by Curator and the CD Export server must be
installed.

1. General installation notes for installing external
software

(Topic number: 7061)

Restart the computer whenever any installation package asks you to do so. For instance, during the
restart at the end of the Windows Server 2003 or Windows Server 2008 installation, the installation
process registers files with Windows and replaces some files. For your installation to work properly,
make sure that if you are asked to restart during the install, you do so before proceeding to the next
step.

2. Installing Windows Server 2008

(Topic number: 94027)

Before installing the product software, Microsoft Windows must be installed. Before you begin the
Windows installation, ensure that the proper CD drivers are installed.

Important!

If using RAID, configure it before installing Windows Server 2008. Use a hardware RAID
configuration only, and not a software RAID configuration. Set up the hardware RAID
configuration as described in the vendor’'s documentation.
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To install Windows Server 2008

1. To boot the system, insert the Windows Server 2008 disc, choose an operating Window Boot
Manager, and click Next.

On the Welcome screen, click Install Now.

From the list, choose Windows 2008 Standard Edition (Full Installation).
Accept the license agreement. Click Next.

Create a C partition as the location to install Windows.

Set the partition size to 40 GB. Click Next.

To set up Windows on the partition, click Next and follow the prompts to install Windows.

® N ANk D

Select Format the Partition using NTFS File System and press Enter.

The partition is formatted and files are copied. Depending on how big the partition is, this
may take several minutes.

9. Follow the setup wizard.

After the installation is complete, the Initial Configuration Task screen is displayed.

3. Partitioning disks

(Topic number: 7032)

To store the files and programs required, create logical volumes as shown in the table in Recommended
disk partitions (refer to page 18). This procedure assumes that the server has multiple disks. If it has
only one disk, create all the logical volumes on the same disk.

Important!

Use the logical volumes only for their prescribed functions. Do not store unnecessary files in
the logical volumes; doing so may negatively affect system performance.

Recommended disk partitions
(Topic number: 7056)

When partitioning disks, consider the following:
« If you have a large disk array (RAID), create more than one CACHE logical volume. Do not
allocate more than 500 GB for each logical volume.

+ For Autopilot to correctly monitor cache space, each cache created in the Administration Tools
must be on its own logical volume.

In either of these cases, assign drive letters to each logical volume sequentially, starting at I, and
name them with the drive letter appended: CACHE-I, CACHE-], and so forth.
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You must create subdirectories in the CACHE or WEBCACHE partitions to store the imaging data.
The existing SYSTEM volume on C should be used for Windows and all program files. The C drive
is 40 GB and is created while installing Microsoft Windows 2008.

Letter  Volume label Size Used for
H LOGS 1 GB Log files
I WEBCACHE-I Remaining space  IMPAX image files

Consider labeling partitions on the Curator
machine WEBCACHE-I, WEBCACHE-]J, and
so forth for the Mitra Wavelet images.

% Note:

Throughout this document it is assumed that a CD or DVD device is assigned to drive D, and
that the drive letters and names shown here are used. The volume letters and labels on your
system may differ from those used here.

Creating logical volumes
(Topic number: 15469)

Before proceeding, ensure that you have determined how to partition the disks. See Recommended
disk partitions (refer to page 18).

Creating logical volumes improves system performance.

To create logical volumes
1. Open the Windows Administrative Tools.

2. Select Computer Management > Storage > Disk Management.
3. Beside Disk 0, right-click OSDisk (C:) and select Shrink Volume.

This restricts the C: drive to the specified size and moves the rest of the available disk space to
Unallocated.

4. Right-click Unallocated and select New Simple Volume.
5. Follow the New Simple Volume Wizard, using the following settings:

Specify Volume Size Simple volume size in MB, as specified in the table in Recommended
disk partitions (refer to page 18)

Assign Drive Letter or + Select Assign the following drive letter

Path
+ Select the letter specified in the table in Recommended disk

partitions (refer to page 18)
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6.

7.

Format Partition + Select Format this volume with the following settings
+ File system: NTFS
+ Allocation unit size: Default

+ Volume label: As specified in the table in Recommended disk
partitions (refer to page 18)

+ Select the Perform a quick format checkbox.

To create any additional partitions, right-click the Unallocated space, select New Simple
Volume, and repeat the previous step.

Exit Disk Management.

4. Configuring Windows Server 2008

(Topic number: 95230)

To configure Windows Server 2008, several tasks are involved.

Completing the initial configuration tasks for Windows Server 2008
(Topic number: 95233)

After installing Windows Server 2008, complete the initial configuration tasks as prompted.

To complete the initial configuration tasks for Windows Server 2008

1.

If the Initial Configuration Tasks screen does not appear on-screen, it may have been disabled.
Open it by running C:\Windows\System32\Oobe.exe.

. Under Provide Computer Information, fill in the information as appropriate.

. Under Update This Server, to ensure that Windows automatic updating and feedback is enabled,

click Enable automatic updating and feedback.

. In the Enable Windows Automatic Updating and Feedback dialog, select Manually configure

settings.

. Under Windows automatic updating, click Change settings.

. In the Change settings dialog, set Windows to download but not install updates.

a. Under Important Updates, select Download updates but let me choose whether to install
them.

b. Under Recommended Updates, clear the Give me recommended updates the same way
I receive important updates checkbox.
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c. Click OK.
7. Close the Manually Configure Settings dialog.
8. Close the Enable Windows Automatic Updating and Feedback dialog.

9. In the Windows update dialog, click Check for updates and follow the prompts to install the
updates.

Upgrading Windows Server 2008 to Windows Server 2008 SP2

(Topic number: 107471)

B caution

This topic provides only basic upgrade instructions. For complete installation instructions,
refer to the applicable topics in the Windows Server 2008 SP2 TechNet.

To upgrade Windows Server 2008 to Windows Server 2008 SP2
. Connect to the network or computer where you want to create the distribution folder.

1

2. In the shared folder, create a distribution folder for the service pack.
3. Copy Windows6.0-KB948465-XXX.exe into the distribution folder.
4

. To install the service pack from a remote shared distribution folder, run
Windows6.0-KB948465-XXX.exe.

5. Follow the instructions in the Setup Wizard.

6. When the installation process is complete, restart the computer.

When the computer restarts, log into Windows as an administrator-level user.

Adding roles and role services in Windows 2008
(Topic number: 104586)

When installing IMPAX on a machine running Windows 2008, configure the following roles and
role services after Windows 2008 installation.
Roles:

« Web Services IIS Features

Role services:

« IIS 6 Management Compatibility

To add roles and role services in Windows 2008
1. Open the Windows Administrative Tools and select Server Manager.

2. Select Roles from the pane on the left.
3. Click Add Roles.
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10.
11.
12.

On the Before you begin page, click Next.

. In the Add Roles wizard, select Web Services (IIS).
. On the Add Features Required for Web Server (IIS) dialog, click Add Required Features, then

click Next.

For the following two screens, click Next.

. In the Add Role Services dialog, select the ASPNET checkbox.

In the Add Roles wizard, click Add Required Roles Services.
Select the IIS 6 Management Compatibility checkbox.
Click Next and follow the wizard.

To finish the installation, click Install.

The installation could take several minutes.

Activating Windows Server 2008

(Topic number: 109368)

Windows Server 2008 must initially be activated.

To activate Windows Server 2008

1.

If you have not already activated Windows Server 2008, open the Control Panel and select
System.

. Click the Activate Windows now link at the bottom of the screen.

Follow the on-screen prompts.

Configuring Windows Explorer to show all files
(Topic number: 47547)

We recommend that you display all available files in Windows Explorer.

To configure Windows Explorer to show all files

AL o

Open Windows Explorer.

Select Tools > Folder Options.

Switch to the View tab.

Under Files and Folders, select Show hidden files, folders and drives..
Clear the Hide extensions for known file types checkbox.

To save the changes, click OK.
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Deleting the hiberfil.sys file in Windows 2008

(Topic number: 118485)

By default, in Windows Server 2008, the hibernation feature is disabled. (We do not recommend
that hibernation be enabled on production servers.) Nevertheless, the hiberfil.sys file used by the
hibernation service may exist on the server, in the root folder of the drive where the operating system
is installed. As this file can become very large, we recommend that it be deleted.

To delete the hiberfil.sys file in Windows 2008
1. Open a command prompt.

2. Type
powercfg.exe /hibernate off

3. Exit the command prompt.

Creating a temporary directory
(Topic number: 49277)

Having a temporary directory on the server can be useful for storing files that you do not have to
keep long-term.

To create a temporary directory
1. In Windows Explorer, select the C: drive.

2. Under Organize, select New Folder.

3. Rename the new folder temp.

Supporting security certificate validation
(Topic number: 47577)

IMPAX uses Windows security certificates to connect the various IMPAX components.

To support security certificate validation
Launch Internet Explorer.

In Internet Explorer, select Tools > Internet Options.

In the Internet Options dialog, switch to the Advanced tab.

Under Security section, clear the Check for server certificate revocation checkbox.
Click OK.

Exit and restart Internet Explorer.

AL o
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5. Configuring the database connection

(Topic number: 7073)

If connecting to an Oracle on Windows AS300 database or an Oracle for Solaris AS3000 database,
install and configure the Oracle for Client for Windows.

If connecting to a SQL database (supported for AS300 Database Server upgrades), configure the

ODBC connection to the SQL Database Server (refer to page 24).

Configuring the ODBC connection to the SQL Database Server
(Topic number: 6813)

Configure the ODBC connection to the SQL Database Server for Windows. This connection is
required for the Archive Server, Network Gateway, and Curator to communicate with an AS300

Database Server running under SQL Server (and therefore does not apply if using an AS300 Oracle
for Windows database or if connecting to an AS3000 Database Server).

To configure the ODBC connection to the SQL Database Server

1.

—_—
—= O

12.
13.
14.
15.
16.
17.

¥ ® N U »N

On the server to connect, open the Windows Administrative Tool and select Data Sources

(ODBCQ).

Switch to the System DSN tab.

Click Add.

In the Create New Data Source dialog, select SQL Server.

Click Finish.

In the Name field, type mvf.

In the Description field, type mvf.

In the Server list, type or select the Database Server name. Click Next.

If asked whether to overwrite the existing MVF_SQL, click Yes.

. Select the SQL Server Authentication option.

. In the Login ID and Password fields, type the username and password for the mvf user.

Ensure that all systems have the same username and password for the Database Server.
Click Client Configuration.

In the Add Network Library Configuration dialog, select TCP/IP. Click OK.

Click Next.

Select the Change the default database to checkbox.

From the list, select mvf. Click Next.

Clear the Perform translation for character data checkbox.
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18. Click Finish.

19. To test the connection, click Test Connection.

20. In the ODBC Driver Connect dialog, type the password for the mvf user and click OK.
21. When prompted that the connection was successful, click OK.

22. To close the Oracle ODBC Driver Configuration dialog, click OK.

23. To close the ODBC Data Source Administrator window, click OK.

6. Installing and configuring antivirus software

(Topic number: 10269)

Install and configure the antivirus software according to the manufacturer’s instructions.

E Note:

Once the IMPAX software is installed, create rules in the antivirus software to exclude IMPAX
processes that are running on IMPAX Clients and Servers. For example, exclude .dcm and
.inf files on IMPAX Client workstations and IMPAX web services on Application Servers.

7.Installing a modem

(Topic number: 7681)

The modem is an optional component. If necessary, install the external modem according to the
manufacturer’s instructions.

8. Installing and configuring pcAnywhere 12.5

(Topic number: 51626)

To allow remote service of the servers, install Symantec pcAnywhere software.

E Note:

Not all servers are shipped with pcAnywhere. Some servers instead use Remote Desktop
Connection. Install and configure pcAnywhere only when appropriate.
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Installing pcAnywhere
(Topic number: 65883)

To connect to remote devices securely for support, install pcAnywhere 12.5 following the
manufacturer’s instructions.

Configuring pcAnywhere
(Topic number: 48237)

After installation, you must configure pcAnywhere.

To configure pcAnywhere

1.

® N AU w D

10.
11.
12.

13.

14.
15.

16.
17.
18.

19.

On the Desktop, double-click Symantec pcAnywhere.

At the Please Register Symantec pcAnywhere message, click Register Later.

At the prompt, click Finish.

Under Views, click Go to Advanced view.

Under pcAnywhere Manager, click Hosts.

Under Hosts, right-click Modem and select Properties.

On the Connection Info tab, verify that modem and TCP/IP are selected. Click Apply.

Switch to the Settings tab. Under Host startup, verify that Launch with Windows is selected.
Click Apply.

Switch to the Callers tab.
From the Authentication type list, select pcAnywhere.
Click New Item.

On the Identification tab, type the login name and password, then type the password again in
the Confirm password field.

Switch to the Privileges tab. Under Caller rights, select Superuser—caller has full access rights
to host machine. Click OK.

Click Apply.

Switch to the Security Option tab. Under Session options, select the Disconnect if inactive
checkbox. Click Apply.

In the Host Properties dialog, click OK.
Under Hosts section, right-click Modem and select Start Host.

Minimize the pcAnywhere Waiting window and confirm that the pcAnywhere icon is displayed
in the system tray.

Close Symantec pcAnywhere.
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9. Installing Adobe Reader

(Topic number: 7679)

Note:

This installation procedure requires a direct Internet connection. If the system does not have
a direct Internet connection, you can use a local Software Update Server instead. To set up
a Software Update Server, contact your IT department.

The IMPAX 6.5.1 guides, quick references, and task summaries ship with the product in PDF format.
To view and print the files, install the latest version of Adobe Reader.

To install Adobe Reader

1.

AR

Go to http://get.adobe.com/reader.

Clear the checkbox for optional software such as the Google Toolbar and McAfee Scan.
Click Download now.
Run the install executable.

In the Acrobat Reader Installation Wizard, select the appropriate options on each screen. After
each selection, click Next.

10. Upgrading to Internet Explorer 7

(Topic number: 47486)

We recommend that you upgrade all Windows 2003 IMPAX servers running earlier versions of
Internet Explorer to Internet Explorer 7. To verify which version of Internet Explorer is being used,
start Internet Explorer and select Help > About Internet Explorer. This procedure is not required
for Windows 2008 server, as Internet Explorer 7 is included with Windows 2008 server.

To upgrade to Internet Explorer 7

1.
2.

Launch Internet Explorer on a computer connected to the Internet.
Go to

http://www.microsoft.com/windows/internet-explorer/ie7/

. From this page, you can either download Internet Explorer 7 or order it on CD.

Once you have obtained the software, run it on each server that needs upgrading.

. To install the software, follow the on-screen prompts.

Curator and CD Export Server Installation Guide—IMPAX 6.5.1 27
Agfa Company Confidential—Subject to Non-Disclosure Obligation


http://get.adobe.com/reader

11. Enabling active content for the Knowledge Base

(Topic number: 7700)

In Internet Explorer 7, all scripts on web pages are blocked by default. The IMPAX Knowledge Bases
use JavaScript for their Search functionality and to render glossary definition popups. If JavaScript
is blocked by the browser, when you view a Knowledge Base page, the definitions of the glossary
terms rendered with JavaScript cannot be viewed, and searching is impossible. Therefore, enable
active content.

Enabling remote access to Knowledge Bases
(Topic number: 10019)

Perform this task to access Knowledge Bases installed on a different server (such as the Application
Server).

To enable remote access to Knowledge Bases
1. In Internet Explorer, select Tools > Internet Options.

In the Internet Options dialog, switch to the Security tab.
Select Trusted sites.
Click Sites.

In the Trusted sites dialog, if you are connecting to the Knowledge Base using http:// rather
than https://, clear the Require server verification (https:) for all sites in this zone checkbox.

AR

We recommend that https:// be used.

6. In the Add this website to the zone field, type or paste the name of the Application Server that
the Knowledge Bases are installed on (https://server_name).

7. Click Add.
8. Click Close.

9. Click Custom Level. In the Security Settings dialog, under Scripting, ensure that Active scripting
is enabled. Click OK.

10. Click OK.

Enabling local access to Knowledge Bases
(Topic number: 10017)

To access the Knowledge Base from the IMPAX Documentation DVD or from a local drive, you
must allow active content (including JavaScript) to run locally.
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To enable local access to Knowledge Bases
1. In Internet Explorer, select Tools > Internet Options.

2. In the Internet Options dialog, switch to the Advanced tab.

3. Under Security, select the Allow active content from CDs to run on My Computer and the
Allow active content to run in files on My Computer checkboxes. Click OK.

4. For the changes to take effect, close and restart Internet Explorer.

You can now run the Knowledge Bases from the DVD or from a local drive.
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Installing and
configuring Curator and
the CD Export server

To create a dedicated Curator and CD Export server, you must install and configure the MVFCurator
and MVFcdexport packages, along with the appropriate Default packages. Before proceeding, ensure
that you have configured the server machine as outlined in Installing hardware and software (refer
to page 17).

1. Installation overview

(Topic number: 7054)

Before installing Curator and the CD Export server, ensure that you have copied the mvf.portable.psd
file to an accessible location. During the installation, the software requests this file and imports the
mvf.psd file under C:\mvf.

H CAUTION!

The mvf.portable.psd file contains sensitive information. To ensure that the security of the
system is maintained, the password file should be deleted after all required components are
installed.

32-bit AS300 installer packages reference

(Topic number: 7682)

The standard (32-bit) IMPAX AS300 installer groups the packages to install under four sections:
default, database, archive, and optional. The following tables explain each package.
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Default

Default packages Purpose

MVFCore Installs the DICOM services for IMPAX and contains several core
Windows services and database tables used by IMPAX.

MVECache Installs the DICOM SCU and autopilot services used by IMPAX and
spftp services. MVFCache includes mvf_compressor, used for lossy
compression, and cache_migration, used to migrate cache volumes from
a flat to a hierarchical structure.

MVEFNetworkGateway Installs the SCP and APIP-SCP services used by IMPAX. Install this
package only on stations that require Network Gateway functionality.
Servers that support only internal transfers, not incoming DICOM
communications, do not require it.

AdministrationTools Installs the Java Administration Tools application for configuring and
managing IMPAX. It also copies the Java Runtime Environment (JRE)
self-extracting executable onto the system.

This package is not available in the 64-bit installer, but must be installed
as part of the IMPAX cluster. Therefore, if installing a 64-bit dedicated
Database Server under Oracle, be sure to install this package on another
AS300 server in the cluster. The package can be installed on more than
one server, but run only one instance at a time (by disabling the other
Administration Tools services).

MVFocr Installs the files necessary to enable Optical Character Recognition. This
is an optional installation that works in conjunction with the
MVENetworkGateway package. Install it only if your system requires
OCR.

The OCR package installs default OCR templates to handle many different
modality vendors. OCR training tools are not included with IMPAX.

VaultAgfa Includes specific requirements and database extensions. Not required on
64-bit systems.

Database

Only one of the two Database Packages can be installed. Install these only on single-host servers or
dedicated Database Servers. For new IMPAX standalone installations, only the Oracle Server package
is supported.

Database packages Purpose

Oracle Server Extension Contains the files necessary to build an Oracle Server database
to be used by IMPAX.

SQL Server Extension Contains the files necessary to build a SQL Server 2008 database

to be used by IMPAX. SQL Server 2000 is not supported.
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Archive

Archive packages Purpose

MVFhsm Installs the HSM package.

Archiving considerations:

« If the server is used for viewing only (no archiving), do not install any archive package.

+ PACS Store and Remember archiving is available but does not require an installation package.
It does require an archive license. For details on setting up PACS Store and Remember archiving,
refer to the IMPAX 6.5.1 Server Knowledge Base.

Optional

Depending on the configuration of IMPAX being implemented, certain packages may not be
supported.

Optional packages Purpose

MVEFCompressor Installs the MVF Compressor package, which includes
mvf_compressor_scheduler. The mvf_compressor_scheduler process is
responsible for scheduling the lossy compression of images.

MVECurator Installs the Curator package. The Curator process compresses incoming
images into Mitra wavelet format and stores them in the web cache.
Studies compressed by the Curator process are served locally or over a
network to display clients.

MVFcdexport Installs the CD Export server, used with the CD Export feature in the
IMPAX Client. The CD Export server processes local burn jobs created
by the IMPAX Client and prepares the zip files containing the data for
the burn job.

For instructions on using CD Export, refer to “Exporting and viewing
images from CD or DVD” (topic number 8209) in the IMPAX 6.5.1
Client Knowledge Base: Extended.

MVEFchangeaccepter Installs a package related to the processing of change context (cc) objects.

This feature is not required and we recommend that this package not be
installed.

MVEFpap Installs the PAP package. A PACS Archive Provider (PAP) acts like a
Service Class Provider (SCP) by receiving studies and allows sites to have
their studies mirrored at another site through PACS Store and Remember
archiving. This mirroring protects against data loss and enables studies
at one PACS to be viewed at another.

For instructions on configuring a PAP, refer to “Configuring a PACS
Archive Provider (PAP)” (topic number 11586) in the IMPAX 6.5.1
Server Knowledge Base.
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Optional packages Purpose

MVForadg Installs a set of scripts and tools for configuring and monitoring Oracle
Data Guard. Data Guard is Oracle’s high-availability solution.

Important!

Data Guard works only on servers running Oracle Enterprise
Edition. Do not install it on a database server using SQL Server
or Oracle Standard Edition, and do not include it on other types of
servers (Archive Server, Network Gateway, Curator, standalone).

AS300 installer log files

(Topic number: 6780)

A log file containing detailed information about the system is created under
C:\mvf\data\logs\SystemInfo.log.

2. Installing the Curator and CD Export server
software

(Topic number: 7047)

To install IMPAX AS300 software, you must be logged into Windows as an administrator-level user.

Use the IMPAX installer to install the necessary packages on the system.

To install the Curator and CD Export server software
1. Insert the IMPAX AS300 DVD.

2. Navigate to D:\programs\mvf and double-click as300-installer.exe.
3. Type your name (minimum three characters).

This information is recorded in the installer log file.
4. On the Welcome screen, click Next.

5. On the Select Components screen, all default packages are selected by default. Clear the
checkboxes of all packages other than MVFCore and MVFCache.
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9. Click Next.
10. Browse to the location of the portable password file and click OK.

11. Type the temporary password used to create the portable password file and click Next.
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The mvf.psd file is imported under C:\mvf.
12. On the Summary screen, click Next.
The files are copied.
13. After all the packages have been installed, click Yes, I want to restart my computer now.

If you are not prompted to restart the computer, manually restart it.

When the server restarts, log into Windows as an administrator-level user.

3.Setting up the Curator web cache

(Topic number: 7029)

If you did not create a web cache for Curator when you configured the Database Server, create the
web cache now. The cache must be created from the Database Server.

E Note:

For Autopilot to correctly monitor cache space, each cache must be on its own partition.

Although multiple Curators may be installed, each Curator places web representations of objects
into the same web cache. This web cache is owned by the master Curator and is managed by the
Autopilot running on the master Curator.

Creating a web cache volume
(Topic number: 7069)

You must manually create cache folders on the system. You can then configure the cache volume
in Administration Tools on the Database Server.

To create a web cache volume
1. On the Database Server, log into the Administration Tools.

2. Click Cache Manager. =]
3. Click New Cache Volume. =]

4. Select Web Cache.
5. From the Station list, select the station where the master curator is installed.
6. In the Path field, type the path for the new cache volume.

* Do not use a trailing slash or backslash at the end of the volume path, because this can
create problems when retrieving images from the cache. For example, do not type
\\server\WEBCACHE]); instead, use \\server\WEBCACHEI.
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+ All caches on the system (image and web) must be shared. Shared caches are specified
without the volume letter; for example, instead of \\server\f$\CACHEI1, use
\\server\CACHEI.

7. Click Add.
8. In the Warning dialog, verify that the path is correct and click Yes.

Configuring cache folder permissions for remote caches and NAS
(Topic number: 7068)

If the cache is hosted remotely or if you are setting up network area storage (NAS), after the cache
is created, create a user account for the ImpaxServerUser on the system hosting the cache.

To configure cache folder permissions for remote caches and NAS
1. On the Database Server, open a command prompt or terminal window.

2. Change to the C:\mvf\bin (AS300) or /usr/mvf/bin/ (AS3000, logged in as root user) directory.
3. To obtain the password for the ImpaxServerUser, type

passkey -M QUERY -u ImpaxServerUser (AS300) or ./passkey -M QUERY -u
ImpaxServerUser(AS3000)

This password is used for the ImpaxServerUser account on the remote machine.

4. If the remote web cache is hosted on a Windows-based system, log into the machine as an
administrator-level user. Using the built-in Windows 2003 Server security configuration, create
an account for the ImpaxServerUser that uses the same password as the account on the Database
Server.

If the web cache is hosted on a Solaris-based system, install and configure a subprocess such
as NFS or SAMBA.

5. If an ImpaxServerUser account cannot be used on the remote cache but rather a domain user
needs to be used, create the domain user and add this user to the ImpaxServerGroup on the
IMPAX machines requiring access (for example, the Curator). Update the IMPAX services to
log in as this new domain user.

Configuring web cache folder permissions
(Topic number: 7077)

If the Curator web cache is on a Windows folder location, to ensure that the cache is accessible, give
the Administrators account and Group account full read, write, and execute permissions on the
cache folder.

To configure web cache folder permissions on Windows Server 2003
1. On the Windows 2003 server hosting the cache, open Windows Explorer.

2. Navigate to the location of the cache.
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10.

11.
12.

13.
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Right-click the cache folder and select Sharing and Security.
Select Share this folder.

Type an appropriate Share name.

Click Permissions.

Select Everyone, then click Remove.

Click Add.

In the field for object names, type Administrators; ImpaxServerGroup, then click Check
Names.

If the names are not found, click Advanced, then click Find Now. Select the Administrators
and ImpaxServerGroup accounts and click OK.

To close the Select Users or Groups dialog, click OK.

In the Permissions for share_name dialog, to give each user full read, write, and execute access
to the cache volume folder, select each user and select Full Control.

Close the permissions and properties dialogs.

To configure web cache folder permissions on Windows Server 2008

— = =
N = O

13.
14.

15.
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On the Windows 2008 server hosting the cache, open Windows Explorer.
Navigate to the location of the cache.

Right-click the cache folder and select Properties.

Switch to the Sharing tab.

Click Advanced Sharing.

Select Share this folder.

Type an appropriate Share name.

Click Permissions.

Select Everyone, then click Remove.

. Click Add.
. Inthe field for object names, type Administrators; ImpaxServerUser, then click Check Names.

. If the names are not found, click Advanced, then click Find Now. Select the Administrators

and ImpaxServerUser accounts and click OK.
To close the Select Users or Groups dialog, click OK.

In the Permissions for share_name dialog, to give each user full read, write, and execute access
to the cache volume folder, select each user and select Full Control.

Close the permissions and properties dialogs.
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4. Configuring the number of concurrent Curator
threads

(Topic number: 9121)

Concurrence defines how many curation threads should run at the same time (each one curating a
different job). Curator performance is optimal when each processor on the machine has a curation
thread. However, to allow other applications such as the SCP the processing time that they require,
set the concurrency level to fewer than the number of processors.

On a single-processor system, the default concurrency level is set to 1. On a multi-processor system,
the default concurrency level is set to the number of processors minus 1. For example, on a system
with four processors, the default concurrency level is set to 3.

E Note:

Hyperthreaded CPUs should not be counted as real cores; for example, in the G6 server
series, the hyperthreading is an option.

To configure the number of concurrent Curator threads
1. Find the service reference value for Curator.

2. In CLUI, to check the concurrence on the machine running Curator, type
SELECT concurrency FROM map_service WHERE service_ref = Curator’s_service_ref
3. To change the default setting, type

UPDATE map_service SET concurrency = number_of curation_threadsWHERE service_ref
= Curator’s_service_ref

4. Restart Curator.

5. Configuring Curator INI settings

(Topic number: 9122)

The Curator settings control how all Curators process images for the web cache. Although the Curator
settings do not exist in the map_ini table when the system is first installed, the default behavior
applies. To change the default behavior to suit your site, add the appropriate settings and values.

To configure Curator INI settings
1. In CLUL to add a new Curator setting, type
INSERT INTO map_ini (ini_section, ini_key, ini_value) VALUES ("CURATOR, 'ini_key',
'ini_value')

or
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To update an existing Curator setting, type

UPDATE map_ini SET ini_value=ini_value WHERE ini_section="CURATOR" AND

ini_key="ini_key"

where ini_key is the Curator setting to change and ini_value is the updated value.

2. To prompt any Curator processes that are running to refresh their configuration settings for

subsequent jobs, type
SIGNAL database_updated

Curator INI settings: Reference

(Topic number: 9119)

The following table explains the Curator INI keys and their possible values.

Default Description of possible values

value

AUTO_DELETE F

COLLECT_PERFORMANCE_ T
METRICS

T—Delete the study from the image cache when the web
representation is created. Curator does not delete images
or other non-image objects from the image cache that
it has not created web representations for. The web cache
copy cannot be sent to other PACS systems.

F—Keep the image cache version as well as the web cache
version. The image cache copy can be sent to other PACS
systems.

Note:

Images compressed using Mitra Wavelet
compression take longer to decompress than
images compressed using standard compression.
To provide faster access to images for local
clients, configure Curator to keep image cache

copy.

We do not recommend deleting the image cache copy
unless the server is configured to function strictly as a
web server.

T—Collect performance metrics on prepare jobs and
store them in map_job_metrics table.
F—Do not collect performance metrics.

The following metrics are recorded in the
map_job_metrics table:
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Default Description of possible values

value

+ SERVICE_REF—Service ref of the curator process
that handled the prepare job.

+ NUM_OBJECTS—Number of objects in the study
being curated.

+ STAT1—Number of frames that were curated.
+ STAT2—Input size of study in MB.
+ STAT3—Raw size of study in MB.

« STAT4—Amount of data written to web cache in
MB.

DELETE_DUPLICATE_JOBS T T—Duplicate PREPARE jobs are deleted.
F—Duplicate PREPARE jobs are allowed.

MIN_MEM_FREE 300 Minimum amount of free memory, in MB, that Curator
requires. If the amount of free memory falls below this

number, Curator restarts. To have Curator ignore this,
set the MIN_MEM_FREE to -1.

If you change this from the default, select a value that is
at least six times the uncompressed size of the largest
image you intend to curate.

QFACTOR_REUSE F T—The Q Factor is reused between compatible
images/frames within the series.

F—The Wavelet Q Factor defined in the Web
Compression Manager is ignored and the Q Factor is
not reused.

We recommend leaving this setting at F (False).

SEND_SIGNALS T T—Send STUDY-SIMPLIFIED MAP signal to the Client.
F—Do not send the signal to the Client.

6. Changing the CD Export file storage location

(Topic number: 7078)

The following procedure applies only if the CD Export package has been installed. By default, files
created by the CD Export process are stored on the C: drive of the CD Export server. For best
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performance, we recommend that you change this location to a non-system drive that has ample
disk space.

To change the CD Export file storage location
1. In CLUL to change the CD Export storage location, type

INSERT INTO map_ini (ini_section, ini_key, ini_value) VALUES ('CD_EXPORT',
'VOLUME_DIRECTORY', 'drive_location')

where drive_location is the location to store the CD Export files in. For example, you could
specify h:\cdexport as the drive location.

2. To define the AE reference of the station where the CD Export storage location is, type

INSERT INTO map_ini (ini_section, ini_key, ini_value) VALUES ('CD_EXPORT',
'VOLUME_DIRECTORY_AE_REF), 'ae_ref')

where ae_refis the AE reference of the station where the VOLUME_DIRECTORY is located.
3. To update the system with the new settings, type
signal database_updated 0 MVF_CDEXPORT

7. Installing a slave Curator

(Topic number: 9116)
If the site requires one or more slave Curators, install these servers by following these steps.

To install a slave Curator
1. Install and configure the external software by following the procedures in Installing hardware
and software (refer to page 17).

2. Install IMPAX on the server by following the procedure in Installing the Curator and CD Export
server software (refer to page 33).

We recommend installing the MVFcdexport optional package on at least one of the slave
Curators, to serve as a potential failover server for CD exporting.

3. Perform the following configurations: setting up Windows firewall rules (refer to page 41),
configuring DEP (refer to page 42), enabling active content (refer to page 28), and enabling
automatic updates.

8. Configuring Windows firewall exceptions

(Topic number: 15509)

The Windows firewall filters and blocks unsolicited incoming network traffic. In some circumstances,
you may want to allow programs and services to access to a specific server port that is normally
blocked by the Windows firewall.
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Note:
To use QStar HSM with IMPAX, open port 160 for UDP messages.

To configure Windows firewall exceptions

1.

10.
11.
12.

Open Control Panel.

2. Select Windows Firewall.
3. Click Change settings.

4.
5
6

Switch to the Exceptions tab.

. Click Add Port.
. Type the Name and Port number.

B caution

If you click OK at this point, the port will be available to all IP addresses. To restrict the
port to specific, trusted addresses, continue with the next step.

Click Change scope.

. In the Change Scope dialog, click Custom List.

. In the field under Custom List, enter a comma-delimited list of IP addresses to give access to

the port.

E Note:

Do not include spaces between IP addresses.

Click OK.
For any other ports to add, repeat from step 5.
When done, to close the Add a Port and Windows Firewall dialogs, click OK.

The new firewall rule takes effect immediately. You do not have to restart the server.

9. Configuring Data Execution Prevention (DEP)

(Topic number: 7192)

Data Execution Prevention (DEP) is on by default for all Windows programs. DEP is designed to
help prevent damage from viruses and other security threats by marking some memory locations
“non-executable” so that malicious code cannot be executed from memory locations that only
Windows and other programs should use. This increased security, however, can cause problems
with some programs that require this memory space, including IMPAX. If DEP remains on, you
may encounter problems with Curator, ddo_store, or CD burns, among other features.
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E Note:

To successfully configure DEP, the directory C:\mvf\bin must already exist. Also, not every
executable listed in step 7 may appear in the directory.

To configure Data Execution Prevention (DEP)

1.

2
3
4.
5
6

Right-click Computer and select Properties.

. Under Tasks in the left pane, select Advanced system settings.

. If not selected, switch to the Advanced tab.

Under Performance, click Settings.

. Switch to the Data Execution Prevention tab.

. In the Performance Options dialog, select Turn on DEP for all programs and services except

those I select.

For each IMPAX executable in the list that follows, click Add, navigate to C:\mvf\bin, select
the executable, and click Open:

a.

=

curator.exe

ddo_create.exe

c. ddo_store.exe
d.
e.

f.
g.

mvf_scp.exe
mvf_scu.exe
mvf_compressor.exe

mvf_autopilot.exe

8. Click OK and close all open dialogs.

9. Restart the system.

When the server restarts, log into Windows as an administrator-level user.

10. Synchronizing clocks on Windows-based IMPAX
systems

(Topic number: 6752)

If the system time on the Application Server and the image server (ASPFTP server) differs, the
authentication tickets provided by the IMPAX Client are rejected by the ASPFTP server and image
retrieval fails. You must configure the IMPAX systems to automatically synchronize their system
time with a common server and remain synchronized.
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Note:

Also ensure that the time zone for the computer is set correctly.

The instructions that follow use the synchronization feature built into the operating system. When
configured, Windows Time Service sets and synchronizes the system time with a standard time
server.

Synchronizing Windows servers to an external time source
(Topic number: 58717)

Synchronize the Windows Server 2003 and Windows Server 2008 servers on your network to an
external time source to ensure that image data streaming operates correctly.

CAUTION!

Serious problems might occur if you modify the registry incorrectly. These problems might
require that you reinstall your operating system and there is no guarantee that these problems
can be solved. We recommend that you back up the registry before you change it, so that
you can back out the changes if necessary.

To synchronize Windows servers to an external time source

1.
2.

To open Registry Editor, select Start > Run, type regedit, and click OK.

To change the synchronization server to NTP, in the
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\Parameters\Type
subkey, change the REG_SZ value from NT5DS to NTP.

. To specify if the local machine is a local time server, in the

HKEY_LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\Config\AnnounceFlags
subkey, change the REG_DWORD value to 5.

To enable the NTPServer, in the
HKEY LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\TimeProviders\
NtpServer\Enabled subkey, change the REG_DWORD value to 1.

. To specify where the computer obtains time stamps, in the

HKEY LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\Parameters\
NtpServer subkey, enter the list of DNS names or IP addresses.

If you use DNS names, append ,0x1 to the end of each DNS name.

. To set the poll interval, in the

HKEY LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\TimeProviders\
NtpClient\SpecialPollInterval subkey, change the REG_DWORD value to the number of
seconds between each poll.

The recommended value is 900 Base Decimal, which polls the time server every 15 minutes.

To specify the maximum positive difference that triggers a synchronization, in the
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\Config\
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MaxPosPhaseCorrection subkey, change the REG_DWORD value to the maximum number
of seconds.

The recommended value is 3600 Base Decimal.

8. Similarly, to specify the maximum negative difference that triggers a synchronization, in the
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\Config\
MaxNegPhaseCorrection subkey, change the REG_DWORD value to the maximum number
of seconds.

9. Exit the Registry Editor.

10. To stop and restart the Windows Time server, at a command prompt, type net stop w32time
&& net start w32time.

It may take up to an hour for this to take effect.

For more information, refer to the Microsoft Knowledge Base article KB 8§16042.

Synchronizing Windows servers to an internal time source
(Topic number: 58720)

Synchronize the Windows Server 2003 and Windows Server 2008 servers on your network to ensure
that image data streaming operates correctly. To configure the Primary Domain Controller (PDC)
master without using an external time source, change the announce flag on the PDC master. Choose
either the Application Server or the AS300 server as the PDC master and synch the other servers to
1t.

ﬂ CAUTION!

Serious problems might occur if you modify the registry incorrectly. These problems might
require that you reinstall your operating system and there is no guarantee that these problems
can be solved. We recommend that you back up the registry before you change it, so that
you can back out the changes if necessary.

To synchronize Windows servers to an internal time source
1. To open Registry Editor, select Start > Run, type regedit, and click OK.

2. To specify if the local machine is a local time server, in the
HKEY_LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\Config\AnnounceFlags
subkey, change REG_DWORD to A.

3. Exit the Registry Editor.

4. To stop and restart the Windows Time server, at a command prompt, type net stop w32time
&& net start w32time.

It may take some time for this to take effect.

E Note:

The PDC master must not be configured to synchronize with itself.
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Synchronizing with a time server when the IMPAX computer is not

a member of a domain
(Topic number: 58572)

To ensure that image data streaming operates correctly when the IMPAX computer is not a member
of a domain, use the synchronization feature built into the operating system.

To synchronize with a time server when the IMPAX computer is not a member of a domain
1. Open Control Panel.

2. Select Date and Time.
3. Switch to the Server Internet Time tab.

4. In the list, type or select the time server to synchronize with.

Synchronizing with a time server when the IMPAX computer is a
member of a domain
(Topic number: 58569)

To ensure that image data streaming operates correctly when the IMPAX computer is a member of
a domain, use the synchronization feature built into the operating system.

To synchronize with a time server when the IMPAX computer is a member of a domain
1. Open a command prompt.

2. Type
w32tm /config /syncfromflags:manual /manualpeerlist:time_server

where time_server is the DSN name or IP address of the time server. The time_server can be
any Windows- or Solaris-based server.

3. To update Windows Time Service to use the new configuration, type
w32tm /config /update

4. To synchronize the clock, type
w32tm /resync
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Troubleshooting IMPAX

As you install IMPAX servers, you may encounter various installation and configuration problems.

Troubleshooting: Installation of IMPAX software
unsuccessful; must reinstall packages

(Topic number: 7685)

Issue
IMPAX Server was not installed successfully.

Details

If the IMPAX Server software installation was not successful, you may have to uninstall the IMPAX
software and retry the IMPAX installation.

Solution

Before retrying the installation, attempt to determine why the installation failed and correct the
problem, if possible. You can find specific error messages and more information on the installation
in these log files:

+ C:\mvf\data\logs\mitra_install.log

+ C:\mvf\data\logs\build_mvf.log

+ C:\mvf\data\logs\build-database.log
+ C:\mvf\data\logs\add_impax_mvf.log

After the problem is determined and resolved, reinstalling the IMPAX software requires four steps:
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. Restart the system as indicated by the installer, even if failures have occurred.

. Determine whether the security components were applied.

If the installation failed after the security components were applied, you must log in using the
AgfaService account to reinstall the IMPAX software. If the installation failed before the security
components were applied, you must log in as a Windows administrator to reinstall the IMPAX
software. Refer to the instructions that follow.

3. Uninstall the IMPAX software.

Install the IMPAX packages again, using the correct user account.

To uninstall the IMPAX software

1.
2.

9.

N oW

Open Control Panel.

In Windows 2003, select Add or Remove Programs.

In Windows 2008, select Programs and Features.

Select AGFA IMPAX AS300.

Click Change.

At the prompt, type your name and click Next.

On the Welcome screen, select Modify. Click Next.

Clear the checkboxes of all installed packages. Click Next.

On the Maintenance Complete screen, select Yes, I want to restart my computer now and
click Finish.

Important!

Do not manually delete the C:\mvf folder as part of the uninstall. If you do, you will have
to re-create and reimport the portable password files.

Log into Windows as the AgfaService user.

You can then reinstall the IMPAX packages.

Troubleshooting: Master Curator fails or is
unavailable and must be reassigned

(Topic number: 7038)

Issue

Web images are not accessible.

Details

If the master Curator machine fails or is unavailable for an extended period of time, you may have
to configure a secondary or slave Curator to take the role of the master Curator.
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Solution

Reassign the master Curator so that a secondary or slave Curator takes ownership of the web cache
and Curator job queue. (Using a load balancer with appropriate configuration may also help mitigate
the risk of this happening.)

E Note:

If the web cache volumes are on the local drive of the master Curator and this machine is
down, the web cache is not accessible if the master Curator is then reassigned. (In most
cases, the web cache is located on a network drive.)

To reassign the master Curator
1. In the Job Manager, halt the Curator job queue.

If wavelet images are needed immediately, reassign a new master Curator without waiting until
all jobs have completed.

or
Wait until all jobs have completed and are no longer in the queue.
2. In CLUI, to change the ownership of the web cache, type

UPDATE osr_volume SET ae_ref = AE_reference_of slave_Curator WHERE volume_type
="W'AND ae_ref = (SELECT ms.ae_ref FROM map_queue mq, map_service ms WHERE
mgq.service_ref = ms.service_ref AND mq.queue_ref = (SELECT MIN(queue_ref) FROM
map_queue WHERE queue_title ="CURATOR"))

3. To change the ownership of the Curator job queue, type

UPDATE map_queue SET service_ref = (SELECT sc.service_ref FROM map_service mc,
map_service sc, map_queue mq WHERE mc.type = sc.type AND mc.protocol = sc.protocol
AND mc.port =sc.port AND sc.ae_ref = AE_reference_of slave_Curator AND mc.service_ref
=magq.service_ref AND mq.queue_ref=(SELECT MIN(queue_ref) FROM map_queue WHERE
queue_title = "CURATOR')) WHERE queue_ref = (SELECT MIN(queue_ref) FROM
map_queue WHERE queue_title = "CURATOR')

4. To signal to all machines in the cluster that the master Curator has been reassigned, type

UPDATE map_ref_count SET ref_count = ref_count + 1 WHERE name =
'"DATABASE_UPDATE_REF'

5. In the Job Manager, restart the Curator job queue.

The Autopilot running on the new master Curator is now responsible for managing the web
cache.
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Security and licenses

The AS300 installation process changes certain Windows armoring, groups, and accounts. Some of
the software provided utilizes or includes software components licensed by third parties, who require
disclosure of information about their copyright interests and/or licensing terms.

Securing Windows-based systems in IMPAX
(armoring): Reference

(Topic number: 9311)

Changes are made during the Application Server installation and armoring procedure to ensure that
the Application Server system is as secure as possible without affecting the functionality of the system.
The following security measures are enforced during the armoring procedure:

All unnecessary services and applications are disabled (refer to page 51).
Insecure network services are disabled.

The ODBC tracing executable is disabled. Disabling this executable ensures that user names
and passwords are always encrypted in the trace log.

Optional services and applications are not installed.

All IMPAX services are configured to run under restricted user accounts that can access only
the resources they need. These accounts are created during the IMPAX installation.

A default list of firewall rules is added to the system automatically, blocking external access to
unused ports where unsecured services could reside if accidentally configured and started. The
default rules are sufficient in most cases, but new rules can be added to increase security for a
particular setup.
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Groups and accounts created for IMPAX

During the IMPAX installation, the ImpaxServerGroup is created and the list of files that this group
has full access to is configured. The Administrators group is automatically created by Windows,
however, the list of files that this group has access to (refer to page 52) is modified during the IMPAX
installation.

The following accounts are created by the IMPAX installation program.

Account Groups that it belongs Services that run under the account

to

ImpaxServerUser + ImpaxServerGroup + AgfaHealthcare

+ IMPAX App Server Data Manager

IMPAX Audit Event Log Manager

IMPAX Distributed License Manager

IMPAX Messaging Service

AgfaService + Administrators + Administrator account used by Agfa support

% Note:

For a service on one machine in a network to access the resources (files and folders) that it
needs on another machine in the network, a user account with the same user ID and password
must be created on each machine. The user IDs and passwords are maintained in an encrypted
password file on the Database Server. Refer to “Generating the AS300 portable password
file” (topic number 7694) in the IMPAX 6.5.1 AS300 Installation and Configuration Guide or
to “Generating and importing mvf.portable.psd” (topic number 6980) in the IMPAX 6.5.1
AS3000 Installation and Configuration Guide.

List of services disabled by the IMPAX installation: Reference
(Topic number: 9309)

The following services are disabled by the IMPAX installation. The Background Intelligent Transfer
and Print Spooler services may be manually enabled on some systems to provide access to print
functions and for the PACS Client Updater.

% Note:

Any services that explicitly depend on these services will fail to start.

Name of service Description of service

Background Intelligent Transfer Used to download files from an HTTP server using idle network
bandwidth allowing no interfering with client browsing.
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Name of service Description of service

Computer Browser Allows a computer to act as a browser master to keep a list of
computers that exists on a network.

Distributed File System Integrates disparate file shares into a single, logical namespace
and manages these logical volumes distributed across a local or
wide area network.

Distributed Link Tracking Client Enables client programs to track linked files that are moved
within an NTFS volume, to another NTFES volume on the same
computer, or to an NTEFS volume on another computer.

Distributed Transaction Coordinates transactions that span multiple resource managers,

Coordinator such as databases, message queues, and file systems.

Print Spooler Manages all local and network print queues and controls all
printing jobs.

Windows Audio Manages audio devices for Windows-based programs.

Windows Error Reporting Service Collects, stores, and reports unexpected application crashes to

(Windows Server 2008) Microsoft.

Windows Update (Windows Enables the download and installation of Windows updates for

Server 2008) Windows Server 2008.

WinHTTP Web Proxy Implements the Web Proxy Auto-Discovery (WPAD) protocol

Auto-Discovery Service for Windows HTTP Services (WinHTTP). WPAD is a protocol
to enable an HTTP client to automatically discover a proxy
configuration.

Wireless Configuration Enables automatic configuration for IEEE 802.11 adapters.

The following services are set to manual by the IMPAX installation.

Name of service Description

Cryptographic Services Provides three management services: Catalog Database Service, which
confirms the signatures of Windows files; Protected Root Service, which
adds and removes Trusted Root Certification Authority certificates from
this computer; and Key Service, which helps enroll this computer for
certificates.

Files that IMPAX groups have access to: Reference
(Topic number: 9308)

The ImpaxServerGroup is created during the IMPAX installation. That group and the IIS_WPG
group have full access rights to the following folders:

ImpaxServerGroup

Access type Locations

Full C:\Program Files\Agfa\Impax Business Services\Messaging Service
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Access type Locations
C:\Program Files\Agfa\Sec\audit\log

C:\Program Files\Agfa\Impax Business Services\License Manager

C:\Program Files\Agfa\Impax Business Services\Audit Event Log Manager

IIS_WPG

Access type Locations

Read/Execute C:\Impax\CDExport
E:\inetpub\wwwroot\AgfaHC.Connectivity.Web.Services
E:\inetpub\wwwroot\AgfaHC.Messaging.Server. WebServices
E:\inetpub\wwwroot\AgfaHC.Pacs.Web
E:\inetpub\wwwroot\AgfaHC.Pacs.Web.Services
E:\inetpub\wwwroot\AgfaHC.RIS.Web.Services
E:\inetpub\wwwroot\AgfaHC.User.Web.Services
E:\inetpub\wwwroot\AgfaHC.User.Security.Web.Services
E:\inetpub\wwwroot\AgfaHC.User.Administration. Web.Services
C:\Oracle

Full C:\Impax\Logs
C:\Program Files\Agfa\Sec\audit\log

External software licenses

(Topic number: 7744)

Some of the software provided utilizes or includes software components licensed by third parties,
who require disclosure of the following information about their copyright interests and/or licensing
terms.

AutoFac 2.1.13

(Topic number: 121742)

Autofac IoC Container
Copyright (c) 2007-2008 Autofac Contributors

http://code.google.com/p/autofac/wiki/Contributing

Other software included in this distribution is owned and licensed separately, see the included license
files for details.
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Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject
to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

Cygwin

(Topic number: 121758)

Copyright 1998, 1999, 2000, 2001, 2002, 2003, 2004, 2005, 2006, 2007, 2008, 2009, 2010 Red Hat,
Inc.

This program is free software; you can redistribute it and/or modify it under the terms of the GNU
General Public License (GPL) as published by the Free Software Foundation version 2 of the License.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY;
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE. See the GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if not,
write to the Free Software Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA.

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139,
USA. Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By
contrast, the GNU General Public License is intended to guarantee your freedom to share and change
free software--to make sure the software is free for all its users. This General Public License applies
to most of the Free Software Foundation's software and to any other program whose authors commit
to using it. (Some other Free Software Foundation software is covered by the GNU Library General
Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses
are designed to make sure that you have the freedom to distribute copies of free software (and charge
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for this service if you wish), that you receive source code or can get it if you want it, that you can
change the software or use pieces of it in new free programs; and that you know you can do these
things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or
to ask you to surrender the rights. These restrictions translate to certain responsibilities for you if
you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give
the recipients all the rights that you have. You must make sure that they, too, receive or can get the
source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which
gives you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone understands that
there is no warranty for this free software. If the software is modified by someone else and passed
on, we want its recipients to know that what they have is not the original, so that any problems
introduced by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger
that redistributors of a free program will individually obtain patent licenses, in effect making the
program proprietary. To prevent this, we have made it clear that any patent must be licensed for
everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.
GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

1. This License applies to any program or other work which contains a notice placed by the
copyright holder saying it may be distributed under the terms of this General Public License.
The "Program", below, refers to any such program or work, and a "work based on the Program”
means either the Program or any derivative work under copyright law: that is to say, a work
containing the Program or a portion of it, either verbatim or with modifications and/or
translated into another language. (Hereinafter, translation is included without limitation in
the term "modification".) Each licensee is addressed as "you".

Activities other than copying, distribution and modification are not covered by this License;
they are outside its scope. The act of running the Program is not restricted, and the output
from the Program is covered only if its contents constitute a work based on the Program
(independent of having been made by running the Program). Whether that is true depends
on what the Program does.

2. You may copy and distribute verbatim copies of the Program's source code as you receive it,
in any medium, provided that you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer
to this License and to the absence of any warranty; and give any other recipients of the Program
a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option
offer warranty protection in exchange for a fee.
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3. You may modify your copy or copies of the Program or any portion of it, thus forming a work
based on the Program, and copy and distribute such modifications or work under the terms
of Section 1 above, provided that you also meet all of these conditions:

a. You must cause the modified files to carry prominent notices stating that you changed
the files and the date of any change.

b. You must cause any work that you distribute or publish, that in whole or in part contains
or is derived from the Program or any part thereof, to be licensed as a whole at no charge
to all third parties under the terms of this License.

c. If the modified program normally reads commands interactively when run, you must
cause it, when started running for such interactive use in the most ordinary way, to print
or display an announcement including an appropriate copyright notice and a notice that
there is no warranty (or else, saying that you provide a warranty) and that users may
redistribute the program under these conditions, and telling the user how to view a copy
of this License. (Exception: if the Program itself is interactive but does not normally print
such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work
are not derived from the Program, and can be reasonably considered independent and separate
works in themselves, then this License, and its terms, do not apply to those sections when you
distribute them as separate works. But when you distribute the same sections as part of a whole
which is a work based on the Program, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the entire whole, and thus to each
and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written
entirely by you; rather, the intent is to exercise the right to control the distribution of derivative
or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program
(or with a work based on the Program) on a volume of a storage or distribution medium does
not bring the other work under the scope of this License.

4. You may copy and distribute the Program (or a work based on it, under Section 2) in object
code or executable form under the terms of Sections 1 and 2 above provided that you also do
one of the following:

a. Accompany it with the complete corresponding machine-readable source code, which
must be distributed under the terms of Sections 1 and 2 above on a medium customarily
used for software interchange; or,

b. Accompany it with a written offer, valid for at least three years, to give any third party,
for a charge no more than your cost of physically performing source distribution, a
complete machine-readable copy of the corresponding source code, to be distributed
under the terms of Sections 1 and 2 above on a medium customarily used for software
interchange; or,

¢. Accompany it with the information you received as to the offer to distribute corresponding
source code. (This alternative is allowed only for noncommercial distribution and only
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if you received the program in object code or executable form with such an offer, in accord
with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications
to it. For an executable work, complete source code means all the source code for all
modules it contains, plus any associated interface definition files, plus the scripts used to
control compilation and installation of the executable. However, as a special exception,
the source code distributed need not include anything that is normally distributed (in
either source or binary form) with the major components (compiler, kernel, and so on)
of the operating system on which the executable runs, unless that component itself
accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source code from the same
place counts as distribution of the source code, even though third parties are not compelled
to copy the source along with the object code.

5. You may not copy, modify, sublicense, or distribute the Program except as expressly provided
under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program
is void, and will automatically terminate your rights under this License. However, parties who
have received copies, or rights, from you under this License will not have their licenses
terminated so long as such parties remain in full compliance.

6. You are not required to accept this License, since you have not signed it. However, nothing
else grants you permission to modify or distribute the Program or its derivative works. These
actions are prohibited by law if you do not accept this License. Therefore, by modifying or
distributing the Program (or any work based on the Program), you indicate your acceptance
of this License to do so, and all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

7. Each time you redistribute the Program (or any work based on the Program), the recipient
automatically receives a license from the original licensor to copy, distribute or modify the
Program subject to these terms and conditions. You may not impose any further restrictions
on the recipients' exercise of the rights granted herein. You are not responsible for enforcing
compliance by third parties to this License.

8. If, as a consequence of a court judgment or allegation of patent infringement or for any other
reason (not limited to patent issues), conditions are imposed on you (whether by court order,
agreement or otherwise) that contradict the conditions of this License, they do not excuse you
from the conditions of this License. If you cannot distribute so as to satisfy simultaneously
your obligations under this License and any other pertinent obligations, then as a consequence
you may not distribute the Program at all. For example, if a patent license would not permit
royalty-free redistribution of the Program by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this License would be to refrain
entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance,
the balance of the section is intended to apply and the section as a whole is intended to apply
in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property
right claims or to contest validity of any such claims; this section has the sole purpose of
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protecting the integrity of the free software distribution system, which is implemented by public
license practices. Many people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that system; it is up to
the author/donor to decide if he or she is willing to distribute software through any other
system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the
rest of this License.

9. If the distribution and/or use of the Program is restricted in certain countries either by patents
or by copyrighted interfaces, the original copyright holder who places the Program under this
License may add an explicit geographical distribution limitation excluding those countries, so
that distribution is permitted only in or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the body of this License.

10. The Free Software Foundation may publish revised and/or new versions of the General Public
License from time to time. Such new versions will be similar in spirit to the present version,
but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number
of this License which applies to it and "any later version", you have the option of following the
terms and conditions either of that version or of any later version published by the Free Software
Foundation. If the Program does not specify a version number of this License, you may choose
any version ever published by the Free Software Foundation.

11. If you wish to incorporate parts of the Program into other free programs whose distribution
conditions are different, write to the author to ask for permission. For software which is
copyrighted by the Free Software Foundation, write to the Free Software Foundation; we
sometimes make exceptions for this. Our decision will be guided by the two goals of preserving
the free status of all derivatives of our free software and of promoting the sharing and reuse of
software generally.

NO WARRANTY

1. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT
WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER
PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS
WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST
OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION

2. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING
WILLANY COPYRIGHT HOLDER, ORANY OTHER PARTY WHO MAY MODIFY AND/OR
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM
(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF
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THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Editline 1.2-cstr

(Topic number: 121768)

Copyright 1992 Simmule Turner and Rich Salz. All rights reserved. This software is not subject to
any license of the American Telephone and Telegraph Company or of the Regents of the University
of California. Permission is granted to anyone to use this software for any purpose on any computer
system, and to alter it and redistribute it freely, subject to the following restrictions: 1. The authors
are not responsible for the consequences of use of this software, no matter how awful, even if they
arise from flaws in it. 2. The origin of this software must not be misrepresented, either by explicit
claim or by omission. Since few users ever read sources, credits must appear in the documentation.
3. Altered versions must be plainly marked as such, and must not be misrepresented as being the
original software. Since few users ever read sources, credits must appear in the documentation. 4.
This notice may not be removed or altered.

ICU License - ICU 1.8.1 and later

(Topic number: 13533)

COPYRIGHT AND PERMISSION NOTICE
Copyright © 1995-2003 International Business Machines Corporation and others. All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the “Software”), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do so, provided that the
above copyright notice(s) and this permission notice appear in all copies of the Software and that
both the above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT OF THIRD PARTY
RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN
THIS NOTICE BE LIABLE FOR ANY CLAIM, ORANY SPECIAL INDIRECT OR CONSEQUENTIAL
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF
THIS SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising
or otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.

All trademarks and registered trademarks mentioned herein are the property of their respective
owners.
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OpenSSL

(Topic number: 121771)

This is a copy of the current LICENSE file inside the CVS repository.
LICENSE ISSUES

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and
the original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both

licenses are BSD-style Open Source licenses. In case of any license issues related to OpenSSL please
contact openssl-core@openssl.org.

OpenSSL License
/>(>

* Copyright (c) 1998-2008 The OpenSSL Project. All rights reserved.

* Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. Alladvertising materials mentioning features or use of this software must display the following
acknowledgment: "This product includes software developed by the OpenSSL Project for use
in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project”" must not be used to endorse or promote
products derived from this software without prior written permission. For written permission,
please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear
in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This
product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)"

*

* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS" AND ANY EXPRESSED
ORIMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THEIMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
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CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

*

*

* This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).

*
*/
Original SSLeay License

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
* All rights reserved.

* This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The
implementation was written so as to conform with Netscapes SSL.

*

*This library is free for commercial and non-commercial use as long as the following conditions are
aheared to. The following conditions apply to all code found in this distribution, be it the RC4, RSA,
lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution
is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

* Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be
removed. If this package is used in a product, Eric Young should be given attribution as the author
of the parts of the library used. This can be in the form of a textual message at program startup or
in documentation (online or textual) provided with the package.

*

* Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library
being used are not cryptographic related :-).
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4. If you include any Windows specific code (or a derivative thereof) from the apps directory
(application code) you must include an acknowledgement: "This product includes software
written by Tim Hudson (tjh@cryptsoft.com)"

*

*THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

* The licence and distribution terms for any publically available version or derivative of this code
cannot be changed. i.e. this code cannot simply be copied and put under another distribution licence
[including the GNU Public Licence.]

*/

Xerces C++ Parser, version 1.2
(Topic number: 121761)

This product includes software developed by The Apache Software Foundation
(http://www.apache.org/). Please read the LICENSE files present in the Help > About dialog of the
IMPAX Client.

Zlib

(Topic number: 7595)

zlib.h -- interface of the 'zlib' general purpose compression library Version 1.2.1, November 17th,
2003

Copyright (C) 1995-2003 Jean-loup Gailly and Mark Adler

This software is provided “as-is”, without any express or implied warranty. In no event will the
authors be held liable for any damages arising from the use of this software.
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Glossary

A
APIP

Agfa Proprietary Imaging Protocol. Used to
receive the proprietary format, reformat the
images to DICOM and redirect them to the
SCP. An APIP SCP is used specifically to
receive images from certain older Agfa image
sources.

Application Server

Intermediary server between IMPAX Client
and IMPAX Server machines. LDAP,
Documentation, and other Business Services
reside on the Application Server.

ASPFTP

Authenticated Simple Partial File Transfer
Protocol. A secure version of the SPFTP
protocol.

Autopilot

Service that removes old and expired data
when the cache starts to get full. This
maintenance function keeps the database to a
manageable size.

C

cache

Temporary storage area for data on a
computer’s local or external hard drives.
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cc objects

Change Context (cc) objects are DICOM
objects used to communicate and synchronize
study metadata changes across multiple
IMPAX clusters.

CLUI

Command Line User Interface. A
command-line tool to help in the service of
IMPAX MVE CLUI allows you to execute SQL
statements.

compression

Reduces the size of a file to save both file space
and transmission time. Lossless, lossy, and
wavelet are examples of compression types.

Curator

Curator is an IMPAX MVF server component.
It is responsible for compressing incoming
images into the Mitra Wavelet format and
storing them in the web cache. These studies
can be accessed by remote or local clients.

D

database

A collection of data that is organized so that
its contents can easily be accessed, managed,
and updated.

DICOM

Digital Imaging and Communications in
Medicine. The standard communication

63



protocol used by a PACS, HIS, or modality to
exchange information or images with other
systems.

E
EPR

Electronic Patient Record. The combination
of all available medical data about a patient,
made available in computerized form.
Electronic patient records are generally part
of a health information system that allows for
storage, retrieval, and modification of records.

F

firewall

On a local area network (LAN) connected to
a larger network, the security system that
prevents outside intrusion and that keeps
internal information from getting out.
Typically, all traffic must pass through the
machine on which the firewall is implemented.

H
high availability

With a high-availability solution, a site is
protected against system downtimes, either
planned or unplanned. Redundant servers are
put in place that can take over functionality
should the primary server become unavailable.

Hounsfield Unit

A Hounsfield Unit (HU) is an X-ray
attenuation (density) measurement used to
describe voxel values in CT scanning. In a
12-bit CT image, the voxel values range from
-1024 to +3071 HU. For example, water is
defined as 0 HU, air as -1024 HU, fat as -100
to -20 HU, soft tissue as +20 to +80 HU, and
bone as > +500 HU. A Hounsfield Unit does
not change no matter how the image is
displayed, since HU is calculated based on
original pixel data.
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HSM

Hierarchical Storage Management. An HSM
archive system provides long-term storage of
data and access to data. Studies archived with
HSM are stored to a file system. A mount
point and subdirectory to store studies to is
specified. The HSM system handles data
storage.

HTTP

Hypertext transfer protocol, a TCP-based
protocol for transferring hypertext requests
and information between servers and
browsers.

image cache

Images arriving in the system and images
retrieved from archive locations are stored in
the image cache. These images are lossless
compressed.

IP address

The Internet Protocol address is a numeric
address that identifies the station to other
TCP/IP devices on the network.

L

load balancing

Distributing processing and communications
activity evenly across a computer network so
that no single device is overwhelmed.

logical volume

Pooled logical extents can be concatenated
together into virtual disk partitions called
logical volumes or LVs. Systems can use LVs
as raw block devices just like disk partitions:
creating mountable file systems on them, or
using them as swap storage. In computer
storage, logical volume management provides
a method of allocating space on mass-storage
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devices that is more flexible than conventional
partitioning schemes.

lossless compression

A compression algorithm in which all data
that was originally part of the file is retained
when the file is uncompressed.

M

master Curator

When using multiple Curators, the
first Curator that runs, which owns the job
queue.

modality

An imaging discipline, such as CT, or a device
that gathers digital information, such as
digitizers for X-ray film, MRI scanners, and
CR devices.

MVE_SCU

A process that handles store and retrieve jobs
for the PACS Store and Remember archive.

N
NAS

Network Attached Storage. A storage device
attached directly to a Storage Area Network
(SAN) or other direct network connection.

Network Gateway

The Network Gateway is part of the IMPAX
MVE cluster. Essentially, this is the workflow
manager of the IMPAX 6.0 and later system.
The Network Gateway controls the studies
coming into the cluster from an acquisition
station, validates these incoming studies
against information from the HIS or RIS, and
routes the validated studies to cache or archive.
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0]
object

An object is usually an image, but may be a
Structured Report Object or any other data
object that is included as part of a study.

OCR

Optical Character Recognition is the
recognition of printed or written characters
by a computer. If a modality generates images
into the system but not enough information
about a study is sent, OCR templates read
information directly from the burned
demographics.

ODBC

Open Database Connectivity. A standard
protocol for accessing relational databases
based around SQL.

P
PACS

A Picture Archive and Communication
Systems (PACS) makes it possible to
electronically store, manage, distribute, and
view images.

PAP

PACS Archive Provider. A PACS Archive
Provider (PAP) acts like a Service Class
Provider (SCP) in that it receives studies.
However, it differs from an SCP in that the
PAP can automatically register a study as
PACS archived if the study originates from a
source that the PACS stores to and remembers
from, without having to queue the study for
archiving back to the source. The PAP can also
parse the private tags of the incoming DICOM
objects to determine HIS verification and
study status.
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Q

Q Factor

Quality factor of lossy JPEG compression. The
greater the Q Factor, the greater the image size.

S

SAN

Storage Area Network. A network of shared
storage devices. In a Storage Area Network, all
storage devices are available to all servers on
a Local Area Network.

SCP

Service Class Provider. A DICOM server that
receives requests from an SCU. The DICOM

SCP accepts images for processing, processes
find and retrieve requests, and handles storage
commitment requests and replies.

SCU

Service Class User. Primarily sends DICOM
requests to an SCP.

series

A set of consecutive images taken by a
modality such as a CT, MRI, or PET. One
study can consist of several series.

single-host configuration

A configuration in which the Database,
Archive Server, and Network Gateway server
components are all installed on a single server.

single-server configuration

An IMPAX single server is a Windows server
that runs the AS300 Server software in a
single-host configuration along with the
Application Server and Connectivity Manager
software.
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slave Curator

When using multiple Curators, the secondary
Curators. Though the master Curator owns
the job queue, PREPARE jobs are associated
with the Curator that started the job.

SPFTP

Simple Partial File Transfer Protocol. A
proprietary transport protocol for
communication within the IMPAX cluster.

SSL

Secure Sockets Layer. A protocol from
Netscape Communications Corporation,
which is designed to provide secure
communications on the Internet.

standalone station

Windows server on which the IMPAX Client,
AS300, and Application Server software are
installed. Runs under Windows XP SP3. The
standalone does not have its own installation
program. To create a standalone , the AS300,
Application Server, and Client installation
programs are each run separately.

W

wavelet compression

Compression method using a proprietary
compression algorithm that can be
uncompressed only by systems that support
that proprietary algorithm.

web cache

Images that have been compressed by Curator
are stored in the web cache. These images are
compressed using Mitra Wavelet compression
to reduce their size for access over low
bandwidth.
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